CREATING/EXPORTING/IMPORTING SCDOT BrR LR TEMPLATES -BrR 7.0
March 2021

This document explains the process for defining, exporting, or importing and using the agency
(SCDOT) truck definitions and load rating templates from/into the BrR 7.0 library.
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Define a Vehicle

1. Open BrR workspace and choose the “View” tab then click “Library”

RIDGE EXPLORER BRIDGE FOLDER
1k Select Al
{Z} Select None

RATE

TOOLS VIEW

“-‘L‘A US Customary |¥ ﬁ
vz —

s

£

P Sort  Select Library Configuration
W Invert Selection By~ Columns
Bridge Explorer View
L Favorites Folder |BiD | Bridge ID | Bridge Name | District | County | Facility |
~ [ Recent Bridges 1 TrainingBridge1 Training Bridge 1(LRFD) District 11 01 Abbeville 58 0051
: gss”d‘?els . 2 | TrainingBridge2 Training Bridge 2(LRFD) Unknown  Unknown [F) N/A
+
mp'e Bridges 3| TrainingBridge3 Training Bridge 3(LRFD) District 11 01 Abbeville 1-79
a
- [ Deleted Bridges 5 N .
4 PClMrainingBridge1 PCI TrainingBridge1(LFD)
5 PCITrainingBridge2 PCITrainingBridge2{LRFD)
6 PClTrainingBridge3 PCl TrainingBridge3(LFD)
7 PCITrainingBridged PCITrainingBridged{LRFD)
8 PClTrainingBridge5 PCl TrainingBridge5(LFD)

2. Select “Vehicles” — “Standard Gage”, then click “New” and define the vehicle details

and type{_asvrengni[ed

Manage

Close

-5 Appurtenances
|- [ Generic
B Median
[ Parapet
[ Railing
B3 Connectors
& Bolt
B Nail
~@ Corrugated Metal Panel
B3 Factors
2o
& LRFD
[ LRFR
[ LRFD DF Applicability Ranges
[ LRFD Substructure Design Settings
B3 Materials
|- Concrete
B Prestress Bar
[ Prestress Strand
[ Reinforcing Steel
- Soil
B Structural Steel
[ Timber
- Wearing Surface
B Weld
-5 Prestress Shapes
[ Box Beams
| Beams
B Tee Beams
[ U Beams
B3 Steel Shapes
- Angle
& Channel
[ Rolled Beam
[ Tee
- B3 Timber Shapes
I [ Rectangular
3 Vehicles

'
I. 5 Non Standardﬁi/
5 Standard Gage

| Library | Units | Name | Description

Standard | SI/ Metric HL-93 (SI) AASHTO LRFD Live Load - S| unit system
Standard | US Customary HL-93 (US) AASHTO LRFD Live Load - US unit system
Standard | US Customary HS 20-44 AASHTO H 20-5 16 Loading, 1944 Edition
Standard | US Customary HS15-44 AASHTO H 15-5 12 Loading, 1944 Edition
Standard | US Customary H20-44 AASHTO H 20 Loading, 1944 Edition
Standard | US Customary H15-44 AASHTO H 15 Loading, 1994 Edition
Standard | US Customary Type 3 AASHTO Type 3

Vehicle: Standard Gage: New ltem %

Name:

Description:

[ Truck | Tandem | Lane

Store units as
o us

Wheel
contact
width

Ande Gage

Axle no. load dist.

Axle
spacing
(ft)

) )

(in)

Minimum | Maximum

Totals:

Library

® Agency defined

User defined

National vehicle
Rating
LRFD
ASD/LFD
LRFR

Design
LRFD
ASD/LFD

3. After completing the vehicle definition, click “Save” to add it to the BrR Library. Click
“Close” to exit the Library Explorer.

N [k - — 3
I =t -8

MNew Duplicate Open Delete | Schemati
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Close

nage
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5 Appurtenances ‘
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Define a LR Template

To capture the full suite of load rating cases for SCDOT, there are a total of 10 load rating
templates split into 2 analysis types: Line Girder and 3D FEM. Each analysis type contains 5
templates: 1 for performing LFR/ASR ratings and 4 for performing LRFR ratings (depending on
the span configuration):

e SCDOT LFR Rating

e SCDOT LFR Rating FEM

e SCDOT LRFR Multi Span < 200 ft

e SCDOT LRFR Multi Span > 200 ft

e SCDOT LRFR Multi Span < 200 ft FEM
e SCDOT LRFR Multi Span > 200 ft FEM
e SCDOT LRFR Simple Span < 200 ft

e SCDOT LRFR Simple Span > 200 ft

e SCDOT LRFR Simple Span < 200 ft FEM
e SCDOT LRFR Simple Span > 200 ft FEM

To define the LR templates:

1. From the BrR workspace, navigate to the “Rate” tab and click the “Rate” button. Define
the template by selecting the appropriate “Rating method”, selecting the appropriate
“Analysis type”, and adding the appropriate vehicles to the “Vehicle summary” window.
Be sure to also update the advanced analysis settings by clicking the “Advanced”
button. Once the template parameters are complete, click the “Save template” button
to save the template to the BrR library.

g

WA
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Export a Truck Definition

1. Open BrR workspace and choose the “View” tab then click the “Library” button

RIDGE EXPLORER BRIDGE FOLDER RATE TOOLS VIEW
Tk Select Al ;}A | | US Customary
{Z} Select None Z —
P ort  Select Library Configuration
W Invert Selection By~ Columns
Bridge Explorer View
L Favorites Folder |BiD | Bridge ID | Bridge Name | District | County | Facility |
~ [ Recent Bridges 1 TrainingBridge1 Training Bridge 1(LRFD) District 11 01 Abbeville 58 0051
: gss”d‘?els . 2 | TrainingBridge2 Training Bridge 2(LRFD) Unknown  Unknown [F) N/A
+
ample Brdges 3| TrainingBridge3 Training Bridge 3(LRFD) District 11 01 Abbeville 1-79
- i Deleted Bridges . N ~
4 PClTrainingBridgel PCl TrainingBridge1(LFD)
5 | PCITrainingBridge2 PClTrainingBridge2(LRFD)
6 PClTrainingBridge3 PCI TrainingBridga3(LFD)
7 PClTrainingBridged PCITrainingBridged(LRFD)
8 PClTrainingBridgeS PCI TrainingBridgeS(LFD)

2. Select “BRIDGE EXPLORER”, then click “Export”, and choose the vehicle(s) you wish to
export. Click the single arrow to move that vehicle(s) to the “selected to export”
window. Click the “Export” button and navigate to the desired location to save the .brix
truck library file.

BRIDGE EXPLORER [T
N (R — — =
y (B
Iy =t - a8
New Duplicate Open Delete | Schematic | Close
Manage
5-B3 Appurtenances Library | Units Name D
-~ g EAE”;”C Standard | SI/ Metric HL-93 (51) A
i seten Standard | US Customary HL-83 (US) ™
- [ Parapet
: Standard | US Customary HS 20-44 A
& Railing Y
B3 Connectors Standard | US Customary HS 15-44 A
- @ Bolt Standard | US Customary H20-44 A
- Nail Standard | US Customary H 15-44 A
]“g Carrugated Metal Panel Standard | US Customary Type 3 A
- B3 Factors
Standard | US Customary Type 352 A
2 /o J
& (reo Standard | US Customary Type 3-3 A
& LRFR Standard | US Customary Alternate Military Loading A
[ LRFD DF Applicability Ranges Standard | US Customary LRFD Fatique Truck (US) A
[ LRFD Substructure Design Settings Standard | 51/ Metric LRFD Fatigue Truck (I} A
=] gté”a‘s Standard | I/ Metric Hs 20 (1) ™
te
[ o one=e Standard | US Customary Lane-Type Legal Load A

® Preferences 9
B
F Database information v
B
I Eport
o [
= Import
s

Deeriptior

" ¥ Type 3-3 - Paveriz w
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Import SCDOT Truck Library

1. Open BrR workspace and choose the “View” tab then click the “Library” button

RIDGE EXPLORER BRIDGE FOLDER RATE TOOLS VIEW

s

£} Select Al :}A = US Customary |¥ ﬁ
{Z} Select None Z —
P Sort  Select Library Configuration
W Invert Selection By~ Columns
Bridge Explorer View
L Favorites Folder |BiD | Bridge ID | Bridge Name | District | County | Facility |
~ [ Recent Bridges 1 TrainingBridge1 Training Bridge 1(LRFD) District 11 01 Abbeville 58 0051
: gss”d‘?els . 2 | TrainingBridge2 Training Bridge 2(LRFD) Unknown  Unknown [F) N/A
+
ample Brdges 3| TrainingBridge3 Training Bridge 3(LRFD) District 11 01 Abbeville 1-79
- i Deleted Bridges . N ~
4 PClTrainingBridgel PCl TrainingBridge1(LFD)
5 | PCITrainingBridge2 PClTrainingBridge2(LRFD)
6 PClTrainingBridge3 PCI TrainingBridga3(LFD)
7 PClTrainingBridged PCITrainingBridged(LRFD)
8 PClTrainingBridgeS PCI TrainingBridgeS(LFD)

2. Select “BRIDGE EXPLORER”, then click “Import”.

BRIDGE EXPLORER

BRSE=E IR~

New Duplicate Open Delete | Schematic | Close

LIBRARY

Manage

B-& Appurtenances
- Generic
@' Median
- Parapet
& Railing
El-E5 Connectors
} & Bolt
- Nail
@' Caorrugated Metal Panel
-5 Factors
- D
& rrD
[ LRFR
[ LRFD DF Applicability Ranges
- [ LRFD Substructure Design Settings

3. Navigate to “Vehicles” — “Standard Gage” in the “Library Items” window and choose the
desired vehicle definition(s) to import by Highlighting them in the “Details” window and

- Concrete
¥ et Dar

T" (3 Materials

| tibrary | Units | Name ]
Standard | Sl / Metric HL-93 (1) A
Standard | US Customary HL-93 (US) 1Y
Standard | US Customary HS 20-44 A
Standard | US Customary HS 15-44 A
Standard | US Customary H 20-44 A
Standard | US Customary H13-44 Ay
Standard | US Customary Type 3 ™
Standard | US Customary Type 352 A
Standard | US Customary Type 3-3 Ay
Standard | US Customary Alternate Military Loading ™
Standard | US Customary LRFD Fatigue Truck (US) Y
Standard | S|/ Metric LRFD Fatigue Truck (1) AN
Standard | 51/ Metric HS 20 (SI) A
Standard | US Customary Lane-Type Legal Load A

then selecting the single arrow to move them to the “select to import” window. Click
the “Import” button to save them to the BrR library.

©

® Preferences
F Database information

I Export

= Import

[ Library Import

Library items:
5 Box Beams
& Circular Void
[ Rectangular Void
& | Beams
} -E2 Narrow Top Flange
(2 Wide Top Flange
[ Tes Beams
7 U Beams
&+ B3 Steel Shapes
2 Angle
& Channel
[ Rolled Beam
3 Tee
B3 Timber Shapes
' [ Rectangular
B3 Vehicles
|- 2 Non Standard Gage
@ Standard Gage

Details:

| Name | Description
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Selected to import:

BB Library
265 Vehicles
-5 Standard Gage
' ¥ SC - 100k Permit
" ¥ SC - 120k Permit
L. 5C - 130k Permit
L. @sc-su2
L@ SC - 5U2 - Permit
. @B SC Crane 2527568
.. @ SC Crane #544726
! ¥ 5C Reprasentative School Bus
" @ SC Reprasentative School Bus
L@ scsHvia
.. SC SHV1A - Permit
L. sC sHVIB
!B 5C SHV1B - Parmit
" @ SC SHV2A
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Export a LR Template
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1. Open BrR workspace, choose “BRIDGE EXPLORER”, then click “Export”

2.

BRIDGE EXPLORER BRIDGE FOLDER RATE

TOOLS VIEW
= - &Import @a L"J [ty 'ﬁ
L& g v ee ][ B
New Open Find Copy Copy Delete
To~
Bridge Manage
7 Favorites Folder | BID ‘ Bridge ID ‘ Bridge Mz

- [ Recent Bridges
- ? All Bridges
- @ Sample Bridges
ﬁ Deleted Bridges

CRENER. ST R RN

TrainingBridge1
TrainingBridge2
TrainingBridge3
PCITrainingBridge1
PCITrainingBridge2
PCITrainingBridge3

Training Bridge 1{LRFD)
Training Bridge 2{LRFD)
Training Bridge 3(LRFD)
PCl TrainingBridge1(LFD)
PClTrainingBridge2(LRFD)
PCI TrainingBridge3(LFD)

® Preferences
F Database information

I Export

PCITrainingBridged
DO Traininnlridnat

PClTrainingBridge4{LRFD)
061 Traininnridnasil EM

H Import

In the “System data items” window, click “Analysis Event Template” and choose the

desired LR template(s) to export by selecting them from the “Details” window and

clicking on the arrow to move them to the “Selected to export” window. When all LR
template(s) have been added, click the “Export” button, and navigate to the desired
location to save the .brsx system data file.

E Systern Data Export

System data items:

BB System Data
-2 Analysis Event Template
- Load Combination Settings Template
- Load Palette Template
-5 System Defaults
- Unit Tolerance
-3 General Preference Template
- Parameters
----- [ Custom Agency Fields Labels

> ]

Details:
| Name | Descripti
HLS.. HL93De
H52... H520LFI
LRFR... LRFR Des
» LRFR.. LRFRLeg
4 Il 4
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Selected to export:

B B3 System Data

EN= Analysis Event Template

. SCDOT LFR Rating
¥ SCDOT LFR Rating FEM
1

----- & SCDOT LRFR Cont. Span <200ft
= &P SCDOT LRFR Cont. Span »200ft
L & scoor LRFR Cont. Span <200ft FEM
= & scoor LRFR Cont. Span »200ft FEM
L & scoot Simple Span <200ft
L @ SCDOT Simple Span »200ft
L & scoot Simple Span < 200ft FEM
L &¥ scoot Simple Span > 200ft FEM

Export | | Close
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Import SCDOT LR Templates

1. Open BrR workspace, choose “BRIDGE EXPLORER”, select the Template file from your
computer that you wish to import, then click “Import”

Ve
BRIDGE EXPLORER BRIDGE FOLDER RATE TOOLS VIEW Brl
L ——= & Import Ly [ty
- I
l—l l‘_'JOBatch' @é |_| | » D:
MNew Open Find Copy Copy Delete <
To~
Bridge Manage Se
- Favorites Folder |BiD | Bridge ID | Bridge Nz Da
2 Recent Bridges 1 TrainingBridge1 Training Bridge 1{LRFD)
@ Al Bridges ) 2 TrainingBridge2 Training Bridge 2(LRFD) Da
ﬁ Sample Bridges . X - .
3 TrainingBridge3 Training Bridge 3(LRFD)
# Deleted Bridges X N = X DB
4 PCITrainingBridge1 PCI TrainingBridge1{LFD)
5 PClITrainingBridge2 PClTrainingBridge2(LRFD)
6 PCITrainingBridge3 PCI TrainingBridge3(LFD)
7 PCITrainingBridged PCITrainingBridged(LRFD)
2 DI TraininAlrid~as D1 TraiminmBridaaSf EMY
2. Inthe “System data items” window, click “Analysis Event Template” and choose the
desired LR template(s) to import by moving them from the “Details” window to the
“Selected to export” window. Import all SCDOT LR templates using the “>>" button.
Then click the “Import” button to save them to the BrR library.
E System Data Import x
Systern data items: Details: Selected to export:
2[5 System Data | Name | Descript > & 3 System Data
) Analysis Event Template EN=) Analysis Event Template
[ Load Combination Settings Template < L. @ SCDOT LFR Rating
-3 Load Palette Template L. @ SCDOT LFR Rating FEM
[ System Defaults L. @ SCDOT LRFR Cont. Span <200ft
(£ Unit Tolerance L. @ SCDCT LRFR Cont., Span > 200ft
-3 General Preference Template L. &¥ SCDOT LRFR Cant. Span <200ft FEM
@ Parameters L @ SCDCT LRFR Cont., Span >200ft FEM
----- [£) Custom Agency Fields Labels I@ SCDCT Simple Span <200ft

----- &¥ SCDOT Simple Span »200ft

----- &¥ scoor Simple Span < 200ft FEM

----- &¥ SCDOT Simple Span > 200ft FEM
ple Sp

4 Il 4 ==

Import | | Close
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Define and Export a General Preferences Template

1. Open BrR workspace, go to the “Tools” tab, then click the “General Preferences” button

BRIDGE EXPLORER BRIDGE FOLDER, VIEW
Simple Bridge Multimedi General
Layout Wizard Attachmentt Preferences Jool
Bridge
-1 Favorites Folder — BID Bridge ID Bridge Name
~@ Recent Bridges 1 TrainingBridge1 Training Bridge 1{LRFD)
f SIS 2 | TrainingBridge? Training Bridge 2(LRFD)
= ¥ Sample Bridges 3 TrainingBridge3 Training Bridge 3(LRFD)
- [ Deleted Bridges = - = :
4 PClTrainingBridgel PCI TrainingBridge1(LFD)
5 PClTrainingBridge2 PCITrainingBridge2(LRFD)
6 PClTrainingBridge3 PCI TrainingBridge3(LFD)

2. Select the desired preferences by moving them from the “General preferences” window
to the “Preference setting” window. Modify the preference settings, as needed, using
the “Edit preferences” button. Once all settings have been modified, click the “Save
template” button to save it to the BrR library.

M General Preferences

General preferences

Preference selection:

Culvert
~Member
~Substructure
~Superstructure

-
Preference setting
Preference setting:
Add to ‘Bridge -
setting Culvert
Superar
-Superstructure
Remove
from setting
Add all to
setting
Remove all
from setting
v
< >
| Open template ‘ | Save template J
| View ‘ Edit preferences |
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To export the saved template, go to “BRIDGE EXPLORER”, then click “Export”. In the
“System data items” window, click “General Preference Template”. Move the desired
template(s) from the “Details” window to the “Selected to export” window and click the

“Export” button. Navigate to the desired location to save the .brsx general preference
file.

(28 System Data Export *
System data items: Details: Selected to export:
=N System Data Name | Descripti - Sl Systemn Data
|
-3 Analysis Event Template =13 General Preference Template
--[£3 Load Combination Settings Template < L @ SCDOT LR BrR Defaults

- £ Load Palette Template

- |E3 System Defaults

-[E3 Unit Tolerance

| General Preference Template
- Parameters

-3 Custom Agency Fields Labels

4 [ 4

Export | | Close
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Import SCDOT LR General Preferences Template

1. Open BrR workspace, go to “Bridge Explorer” then click “Import”. Select the general
preferences file on your computer to import

Database information s @
® Preferences Coopectad
- Build date SO0 LR B4 Delauhs bra
2007 LR Tamplates b
F Database information Version
BrM and BrDR share this data
I Export
- Database connection and dri
E Import
Server name localhost
\!a Print DataSource name localhost
Database name  AASHTOW
® Help DBMS neme  SQL Server
™ Edt P s | SCDOT L E0R Defuits s ystam Duts supost i ")
xi Cpen are

2. Inthe “System data items” window, click “General Preference Template”. Move the
desired template(s) from the “Details” window to the “Selected to export” window and
click the “Import” button add to the BrR library.

System data items: Details: Selected to export:
BB System Data Name | Descripti > 2[5 System Data

-(E Analysis Event Template - General Preference Template
[ Load Cambination Settings Template < L. @ SCDOT LR BrR Defaults
-3 Load Palette Template

-2 System Defaults

@ Unit Tolerance

- General Preference Template
Lf) Parameters

----- [ Custom Agency Fields Labels

4 il 4

| Import || Close |

3. To apply the SCDOT General Preferences to a bridge file, click to select the bridge in the
bridge explorer, click the “Tools” tab, then click “General Preferences”. From the
“General Preferences” window, click the “Open template” button and select the
“SCDOT LR BrR System Defaults” template to open these settings. Click the “Apply”
button to apply these settings to the selected bridge.
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BrR 7.0 BRIDGE EXPLORER tabs

- Bridge: create new bridge, open bridge from workspace, import bridge, copy or delete.

ERIDGE EXPLORER BRIDGE FOLDER RATE TOOLS VIEW
\j 1 & Import @é E‘I‘J | L ‘ﬁ
n Batch =

MNew Open Find Copy Copy Delete
To~
Bridge Manage
| L---{'ﬁ'} Ezumritar Enldar | | | mar | n_oa__am

- Folder: create new folder, edit existing folders.

BRIDGE EXPLORER BRIDGE FOLDER RATE TOOLS VIEW
il +

MNew Add to

Favorite

Folder Manage

- Rate: rate a structure, show rating results, manage analysis events.

BRIDGE EXPLORER BRIDGE FOLDER RATE TOOLS VIEW

> T I T
= if = |
Rate Rating Manage Analysis | Open
Results Events
Rate Results Routing Rating Tool

- Tools: define/import/export general preferences.

ERIDGE EXPLORER ERIDGE FOLDER RATE TOOLS VIEW

;s & g A

Simple Bridge Multimedia  General Report
Layout Wizard Attachments Preferences Tool

Bridge

[ - " L | [ I —— 1 — ——

- View: define/import/export Library items.
ERIDGE EXPLORER ERIDGE FOLDER RATE TOOLS VIEW

I} select All =h US Customary |¥ r o
¥7 = ““f.,,}

m Select Mone -

e Sort  Select Library Configuration
'_!,' Invert Selection B}' * Columns

Bridge Explorer View
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BrR 7.0 BRIDGE WORKSPACE tabs

The “Bridge Workspace” interface is opened after creating a new bridge, opening an existing
bridge from the “Bridge Explorer” interface or importing a bridge to BrR.

Bridge: displays main components, edit and create superstructure definitions, edit and
create bridge alternatives.

x| Bridge Workspace - 02090 ANALYSIS ? - B8 X
BRIDGE WIORKSPACE WORKSPACE TOOLS VIEW DESIGN/RATE A
A Check Out [ 5 é Restore 6 3 L = iy (B - ‘ﬁ =
F =l E# | |8 “>
4y Check In |_| & Revert - = 0 _
Validate Sawe Close Export Refresh Open MNew Copy Paste Duplicate Delete | Schematic
Bridge Manage
Workspace rox ‘ Schematic 2 % || Report r X
Components
4D 02090
& ) Components
L Barrier
DB|-3&
- T foc=8ksi
- 88 0.6" (TW-270) LR
----- @ Grad= 60

ﬂ Diaphragm Definitions
ﬂ' Lateral Bracing Definitions
- MFF LRFD Multiple Presence Factors
- ES Environmental Conditions
- DF Design Parameters
B 5 SUPERSTRUCTURE DEFINITIONS
=8 b Span 1 As-built (2019-10-22)
j_ Impact/Dynamic Load Allowance
-t load Case Description
- ¥ Framing Plan Detail
~ [ Bracing Deterioration
- BSC Bracing Spec Check Selection
m Structure Typical Section
- gHe Superstructure Loads
5 [ Stress Limits
38 ’ Prestress Properties
38 ’ Shear Reinforcement Definitions
£ [ MEMBERS
= | BRIDGE ALTERNATIVES
B D As-Built (2019-10-22) (B) (C)
i [ SUPERSTRUCTURES
- 4 Stiffness Analysis
..... w PIERS

Analysis

T
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e

Workspace

- B Components

B 5] Appurtenances
- |2 Generic

- &2 Median

- &3 Parapet

----- L. Barrier
----- & Railing

= |5 Beam Shapes

-~ &1 Beams

Eet- WConnectors
Ee- wFactors

= ) Materials
LJ—}" 2 Concrete

----- @ Grade 60

- [ soil

- a Timber

- &) Prestress Shapes
- = Box Beams

L [JBl-36

|2 Tee Beams
----- 53 U Beams
B [ Steel Shapes
B [ Timber Shapes

w LRFD Substructure Design Settings

Lo T o= 8ksi
B Prestress Bar
=3 E Prestress Strand
i L 88 0.6" (TW-270) LR
= | Reinforcing Steel

W Structural Steel

Schematic

Analysis

TOOLS VIEW DESIGN/RATE

Close Export Refresh Open

Workspace: save bridge changes, export, edit bridge elements, show schematic.

CREATING/EXPORTING/IMPORTING SCDOT BrR LR TEMPLATES - BrR 7.0

Components: edit and create parapets, beam shapes, materials... etc., which are to be
used in the Bridge workspace.

—
i

Schematic
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Tools: apply general preferences.

ERIDGE WORKSPACE WORKSPACE TOOLS VIEW DESIGN/RATE

g & 2

Multimedia General Report
Attachments Preferences Tool

Bridge

View: add/remove bridge superstructure or substructure, culvert, expand or collapse
branch.

L i TR TR TSR

BRIDGE WORKSPACE WORKSPACE TOOLS VIEW DESIGMN/RATE

%3 Expand Branch |v*| Superstructures Compact 6
? Collapse Branch Culverts
Restore
v*| Substructures Layout
Bridge Workspace View Window | Dock Management

Design/rate: define analysis settings, run analysis, display analysis results, plot results.

BERIDGE WORKSPACE WORKSPACE TOOLS VIEW DESIGMN/RATE

1% > (B
= & |i= oo~
Analysis Analyze Analysis Engine
Settings Events Outputs
Analysis Results
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Rating a Bridge from the Bridge Explorer

1. Select the bridge you wish to rate in the “BRIDGE EXPLORER” workspace. Navigate to

March 2021

the “Rate” tab, then click the “Rate” button

BRIDGE EXPLORER BRIDGE FOLDER RATE TOOLS VIEW
L= b
Rating Recent Rating Manage Analysis | Open
Results Results Events
Rate Results Routing Rating Tool
14 Favorites Folder BID Bridge ID Bridge Name Di
-2 Recent Bridges 1 TrainingBridge1 Training Bridge 1(LRFD) Dist
- Al Bridges . 2 TrainingBridge2 Training Bridge 2{LRFD) Unk
# Sample Bridges 5 -
... Deleted Bricges 3 Tralnm.gBr\dgfaS Tramms Fndg.e 3(LRFD) Dist
4 PClTrainingBridge1 PCl TrainingBridge1({LFD)
5 PCITrainingBridge2 PCITrainingBridge2(LRFD)
6 PClTrainingBridge3 PCI TrainingBridge3(LFD)
7 PClTrainingBridged PCITrainingBridged{LRFD)
8 PCITrainingBridge5 PCl TrainingBridge5(LFD)
9 PClTrainingBridge6 PCITrainingBridge&(LRFD)
10 Example? Example 7 PS (LFD)
11 RCTrainingBridgel RC Training Bridge1(LFD)
12 TimberTrainingBridge1 Timber Tr. Bridge1 (ASD)
13 FSys GFS TrainingBridge1 FloorSystem GFS Training Bridge 1 Dist
14 FSys FS TrainingBridge2 FloorSystem FS Training Bridge 2 Dist
15 FSys GF TrainingBridge3 FloorSystem GF Training Bridge 3 Dist
16 FLine GFS TrainingBridgel FloorLine GFS Training Bridge 1 Dist
17 Fline FS TrainingBridge2 FloorLine FS Training Bridge 2 Dist
18 Fline GF TrainingBridge3 FloorLine GF Training Bridge 3 Dist
19 TrussTrainingExample Truss Training Example
20 LRFD Substructure Example 1 LRFD Substructure Example 1
27 LRFD Substructure Example 2 LRFD Substructure Example 2
22 LRFD Substructure Example 3 LRFD Substructure Example 3
23 LRFD Substructure Example 4 LRFD Substructure Example 4 (NHI Hammer Head)
24 Visual Reference 1 Visual Reference 1 Dist
25 Culvert Example 1 Culvert Example 1
26 LFD Curved Guide Spec LFD Curved Guide Spec Example
27 MultiCell Box Examples Multi Cell Box Examples
28 Gusset Plate Example Gusset Plate Example Dist
29 Splice Example Splice Example
nt LL-Splice Simple DL Splice Unk
02090 Dist
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2. From the Analysis Settings window, click the “Open template” button if you wish to load
a saved template, or create a rating scenario by adding vehicles from the “Vehicle
selection” box to the “Vehicle summary” and click “OK”

gn revie Rating \Ratmg method LRFR v
\ Save analysis results
Analysis type: Line Girder v

Lane / Impact loading type:  As Requested v Apply preference setting: | None v

| Vehicles | Output | Engine | Description

Traffic direction: | Both directions v [ Refresh | [ Temporary vehides | [ Advanced
= Vehides ~ Rating vehicles ~

E-Standard E-LRFR
Ev2 5 Design load rating
Ev3 Inventory
H 15-44 L HL-93 (US)
H 20-44 Operating
HL-93 (51) LHL-93 (US)
HL-93 (US) Fatigue
HS 1544 +Legal load rating
HS 20 (51) Routine
HS 20-44 Modified AASHTO 5C - Type 3
Lane-Type Legal Load |- Modified AASHTO 5C - Type 352
LRFD Fatigue Truck (S1) Type 3-3
LRFD Fatigue Truck (US) Remave from -Specialized hauling
NRL V2
su4 B3
sUs ¢ -suz
sus SC Representative Schaol Bus
su7 [-5C SHV1A
Type 3 SCsHVIE
Type 33 |-5¢ sHv2A
Type 352 SCsHvze

i-Agency |-s¢ skvzA
Lane Type Permit Load SCsHvag
Lane Type Permit Load-Bair su4
Medified AASHTO SC - Type 3 |--sus
Modified AASHTO SC - Type 3 - Permit sus
Medified AASHTO SC - Type 352 -SU7
Modified AASHTO SC - Type 352 - Permit =-Permit load rating
5C - 100k Permit - Modified AASHTO 5C - Type 3 - Permit
SC - 120k Permit ' Adjacent vehicle
5C - 130k Permit = Modified AASHTO 5C - Type 352 - Permit
SC-SU2 ' Adjacent vehicle
5C - SU2 - Permit =-5C - 100k Permit
SC Crane #527568 " Adjacent vehicle
SC Crane #344726 i SC - 120k Permit
SC Representative School Bus - Adjacent vehicle
5C Representative Scheol Bus - Permit =5C - 130k Permit
SCSHVIA ' Adjacent vehicle
SC SHV1A - Permit #5C - SU2 - Permit
SCSHV1B v ! Adjacent vehicle v

Reset || Clear |( Opentemplate [J| save template ‘ I
N~/

3. Check the rating progress in the “Analysis Progress” window and check the results in the
“Bridge Rating Results” window.

u Bridge Rating Results

System of units Lane/impact loading type Display format:

® US customary | S/ metric ® As requested Detailed Single rating level per row w
Bridge ID | Vehicle RI:E‘:IQ f::;:? ::;_:’gd C??::;ty Time stamp Rabt:d Impact | Lane | Ug
03087 EV2 Legal 1.723 | LRFR 49528 | Thursday,... | Brr | AsR.. | As..
03087 EV3 Legal 1118 | LRFR 47967 | Thursday,... | Brr | As R,
03087 HL-O... | Inventory 1.154 | LRFR 41.554 | Thursday,... | Brr Az R | As..
03087 HL-0... | Operating 1.496 | LRFR 53.866 | Thursday,... | Brr Az R | As.
03087 Modi... | Legal 1.940 | LRFR 48408 | Thursday,... | Brr | AsR.. | As..
03087 Modi... | Permit 2.522 | LRFR. 63.048 | Thursday,... | Brr | AsR.. | As..
03087 Modi... | Legal 1.950 | LRFR 71355 | Thursday,... | Brr | AsR. | As.
03087 Modi... | Permit 2498 | LRFR 91419 | Thursday,... | Brr | AsR.. | As..
03087 SC-.. | Permit 1.896 | LRFR 94,790 | Thursday,... | Brr | AsR.. | As..
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Rating a Member from the Bridge Workspace

1. Inthe Bridge Workspace, navigate to the “Workspace” box, then to the “Bridge” tab
and choose the member alternative you wish to rate.

i ] Bridge Workspace - 03087 ANALYSIS

BRIDGE WORKSPACE WORKSPACE TOOLS VIEW DESIGN/RATE

& " % % B

Analysis Anzlyze Analysis | T n Engine
Settings Events C ail Outputs Gr
Analysis Results

orkspace ® x || Schematic

Companents

- My 03087
B @' Compaonents

w Diaphragm Definitions
- B Lateral Bracing Definitions
- MFFLRFD Multiple Presence Factors
- EC Environmental Conditions

-~ OF Design Parameters
& |3 SUPERSTRUCTURE DEFINITIONS
-- b Spans 184 As-Built (2019-07-
= brf Spans 283 As-Built (2019-07-
-~ Impact/Dynamic Load All

- gt Load Case Description
- A5 Framing Plan Detail

- [ Bracing Deterioration
-~ BSC Bracing Spec Check Selecti
% Structure Typical Section

- aHy Superstructure Loads

- [ Shear Connector Definitian
B [ Stiffener Definitions
= &) MEMBERS

g I Gl
e Member Loads

Analysis
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2. Go to the “Design/Rate” tab and click the “Analysis Settings” button. Load or create the
rating template and click OK. Click “Analyze” to rate the member. Check the member

analysis progress in the “Analysis” window.

WORKSPACE  TOOLS  VIEW W
= Rl =
® X H

Analysis Analyze Anglysis | Tabular Specification Engine Results Save

BRIDGF WORKSPACE

Settings Eyents | Results Check Detail Outputs Graph Results
Analysis, Results
Workspace ® x || Schematic 2 x || Report L

I?H Components
- 4M 03087

% w Components
w Diaphragm Definitions
- @ Lateral Bracing Definitions
- WFF | RFD Multiple Presence Factors
E€ Environmental Conditions
- OF Design Parameters
=+ 3 SUPERSTRUCTURE DEFINITIONS
brrf Spans 184 As-Built (2019-07-
= befl Spans 283 As-Built (2019-07-
-+ =4 Impact/Dynamic Load All
- 2+ Load Case Description
- 4% Framing Plan Detail
- E’ Bracing Deterioration
BSC Bracing Spec Check Selecti

mstructure Typical Section
e Superstructure Loads
[ Shear Connector Definition
- [ Stiffener Definitions
- [ MEMBERS -
Ia 4 Rralysis Event - Location - 57.4497 (1) 2
- gle Member Loads - Location - 65—"833-0 ()
@a Completed Specification Check.
i “A Supports Info - LRFR analysis successfully completed!
- £ MEMBER ALTERNAI Info - Populating LRFR rating summary..
B I Gl © Info - Analysis completed!
- I G2 -
- I G3(G2) v
b I < I >
- T 55(62) .
- T G61G2) iOEnuls|&w;.mgs' 3

3. Check the member rating results by clicking the “Tabular Results” button or clicking the
“Specification Check Detail” for detailed rating calculations.

QLS VIEW DESIGM/RATE
"
plegd E

WO

BRIDGE WORKSPACE

Analysis Analyze Analysi Results Save
Settings Events\ | Results Check Detail Outp Graph Results
Analysis
Workspace Schematic R

&M 03087
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